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Design of wheelchair patient transferring device

Pongsathon  Manoworakul
Pasaphong  Kittiphongtorn
Rachapol Sawaengwaisayasuk

Asst. Prof. Dr. Akapot Tantrapiwat  Advisor

Abstract

The objective of this project is to design the device for moving the elderly from
wheelchair to car. The targets of this device are the family which has only one caretaker or
caretaker who is not strong enough. This device was designed and calculated by a finite
element analysis method based on 100 kg of the elderly. The results of this analysis method
showed the maximum stress of this device is equal to 140.5 MPa and maximum displacement
at the end of the handleis 12.9 mm. which is equal to 0.95% of devices’ height. The factor of
safety is 3.67. By designing, this device can lift 100 kg and use for the width of the car door

which is not less than 400 mm.
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P(x) = FC+V (2.13)
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FC fie fuvunsiisa
% A AU uukUIHoNIY

INFUNTTN - D NHIIHBINITNIT VAL IUNUILUDIFUANNIZHAALALTINUY AN LA

AUVLUNBF AU

9

P(x) = FCHV(x)
P(x) -V(x) = FC
x(P-V) - FC
X == (2.14)
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3.2.2 wuuaasnlglunisaiuay
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v [

NNFUN 3.3 aglednsvesenluyy 22 eamannuuiseivavsesegluyiessey 302.14 wu. - 520.35 1.

NFUN 3.4 aglednszezenluyy 52 BamanuuITEavaIiesegluyiessey 197.85 Uil - 437.36 L.
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satilumauiidaaunsoagulainainnsdiil 1 way 2 svuzenves Linear actuator Niaunsasdululaiien

WINAU 300 Uy, — 340 4.

3.3.3 szazennmeldweuledl 4 : gunsalilionuudlazdesaunsaladilulutaaniuaesingse

UIA 150 FU.X 85 X 45 @l 19

750 m

250 mm

75 mm

gﬂﬁ 3.11 uans Free body diagram LLUUﬂilTJGUaGQUﬂ‘iif!

[

FaFUTAN UL

LF, = ussflosmnihndnvesdaeny @siuualidldniiiu 981 N; ¢ = 9.81 m/s%)
2.Fy = us39usnil Linear actuator dadldlunisengunsainseusasens ; N
3.0, = 3u09QUNIAIIINAULLITIU ; B9en

4.0, = yUUBLIIAN Linear actuator MYNAULNULNYBRUNTATIIANUAUAT ; B3FN

5 A

ALY

6. X 3¥828NVDY Linear actuator Lﬁafﬁﬂﬂﬂqﬂwqu A mm
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Tuudvmudungn A = Judanuduiign A
azlain
Facos(0,) x Xcos(0;) =F,, x 750cos(0;)
AITULTY Fy 7190ba qazdidnindu

~ Fy x750co0s(6;)
- cos(0,) x Xcos(0;)

_ 750F,
AT Xcos(8,)
Faruduiusszning 0; uaz 0, fe
W o Xco0s0;-75
M2 7 Xsind,+250

[

nuudslalusunsy Microsoft office Excel Tunisaruiumusiszogang quaitanasensinlasal

2900

2811,600784
2800

2700

2600 2565,283967

2500

W39 (H6)

2514,098062
2400

2300

2200 2235,564726

2100
300 310 320 330 340

syezen (Hadung)

— ) c—1] 32 37 42 47 52

JUT 3.12 psvluansanuduiusseninasvezeniuusanldnyueing o
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v
IS DR 4 L

| a a .:4' v I3 .:4' ca'
ANNTINTNUANEITEELLNUAINN LLi\‘Wﬁ]gmaﬂiﬂUﬂqiﬂﬂﬂﬂﬁﬂﬂquaﬂaﬁ AIUUINNNTINGD 3.1 Feezenn

Fonltfe 340 Haans F991NAIATUIMBE1IATNGALIAILTITIRosldRARaE e toaUsEaM 2566 T

3.4 n15+88n Linear actuator

[

dmsunsiden Linear actuator 119 web site vasfaunusmineSauseail
1. Linear actuator 3000 N
2. Linear actuator 6000 N
3. Linear actuator 8000 N

FaNa 3 JuiTIAWINU

fratiuannNIsAInluTe 3.3.3 aglaiusindesldiarUseunn 2566 TRdudadulssinnaInnIsan
1 | LY M ¥ o [y Y Y PV 1 a A Y= Q .
ag A wazdaliladwiusiniudmdnuesgunsal st Linear actuator Mdantddudu Linear

actuator 6000 N

3.5 N1SLAANTEN

a

PHINYINNITLADNVUINLASTLTENUDY Linear actuator saunlnvinnisidenianiazuunlalu

q

nsiaesiall InuEuINNISMIRSINLINNEANNsEULTLEILR 19 vRIaUN Tl

UM 3.13 uansnmangauntiiasaudinwesaunsal
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ANAINRIETIPTUNTBAE AIUT TN USEnaUlUMeTUdundnNTanus 9 T launs

(% (% '
[ 0 = £ o a

Aasziusinszyiiuinguiazduiu S1duiinzderaununiningdassvaniudinieniazlidiely

(2 (%
v A

AW tnswsastudutuliuvunwiandaseasiolul

W=981N

Cy Dy

SUTI 3.14 uansnushasuunningdasyvessiile

Cy Dy

h 4

“— Gx Hx T

Gy Hy

JUN 3.15 LanadnuaizlasLEuWIngdaszvasiauy



27

JUT 3.16 uanwmnuaslazuuningdaszvaawnuenly

= (2T ATy —

JUN 3.17 UanIaNYMELAL UNUNNINGBATYYRIFIEALN YN

Hx

Mx

My

SUT 3.18 wanddnuazlasiuAWIngdaseveaunuenuen



Jx

Ly

JUN 3.19 UanainuzlasuNuNINIngBasyyed Linear actuator

S)(ﬁ

5UN 3.20 uansanyziazununIning dasevesmdaian

Ky
Kx
'ﬁ
Sx h
Y
L ]
Qx
r'y >
Qy

JUT 3.21 uansinuuzlazununmingdassveanly
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My

Mxh

—’Ox

Rx —

Ry

JUT 3.22 LanadnuglasiuA N Ing sy vediauen

v o

WRIINNIIAIIULATRAAUNIIIANTD IS ULl wssiflanannfidgadaunss Q, Talu
A o = A " A o A ] = o =
L.LiwmzmmamﬂuLLazg’msaﬂLﬁ’]smm’lmfmu 3876.21 UINU BNINUANYBILIINAILYINUINYIFA
1A NAINUUADIAUIUMIAT Normal stress Ainsemsianlulazan Bending stress Minsgyinme

FIUT0%ET AolUl

A15AUIMY Normal stress Ainszyinsatanlu

tgns

Q
I
>

g9l F = 3876.21 92 way A = 1017.25 1514581105

fetiy A1 O = 3.81 wnzUrdAa

N13AINMT Bending stress MInsgyisogusean
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tgns

o= —

Taefl M = 605.84 Taduins, C = 0.016 1AS

LAY | AIUIRIN

1aA1 | 98nUNAD 6.74x10°8 Wns*

Aty e Bending stress MAnTuiugiuseuanildnviniu 143.68 MPa

13 '
= )

INMIAUIUILIUIT Bending stress MAnTufsIusosaiiaunian fs 143.68 MPa faan

9 9

v ) PN v ° v v Ay a ' ) v v
foansmidnfionld Tnefmualimaulasadeiidesnsiidunnda 3.5 Tunueaituindedld

[y

TanilAUAUNINATINGINATY 502.88 MPa

(%
v v o= A

i Judenlindn AISIL045 NTlANAUAATINWINAY 530 MPa unldlunisdiaestusu
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4.1 A1AUTUNDULALYDINNG LUN1TIDNLUU

4.1.1 a1 UTUNBUIUNITIBNKUU

[ | |

TunseenuwuuTudIuLAzToRBsY Ua3gUnTalRlinITENRUTUADUNNTRBNLU UL NI TRBNWUUYTI

Iehetuaziluszuulagadutunaulunisesnuuunansamunuinsgusdeluil

[ AMuuATaInANg qlunsesnuuy ]

)

[ InsgiwazUuleunlasuy ] :[ d1539andie qiduneluionana ]

| !

[ m'ﬁaammugﬂ'ﬁwwm%umu NMYUATUIALAZYTAYDIIER ]

!

[ MALUUBUOUMBlUILATUADUNILADS ]

)

[ NAADUTUIUMILTUSUNTUADUNILADS LA¥ATIFFDUMIBNITATUIUNING Y ]

ladeinu

I
v H

[ asunanisesnuuulasiauiionsidauaswely ]

JUN 4.1 uansdiudunaunseaniuy
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4.1.2 dafinlun1soanuuy

Tun1seonuuuiudunazdosang queunsal Ve dinnaIe o8 19nIe ity AINEIaY
duguazelAliiiuanugeeioss anuniwesvuenlzieamliiununiawesielses
50 uagTEEEvRILLNITFesNAfisweTiazansadsdgsongitluluisaldlnglivuveuusnidy uay
fiddnyzunuuuey TasuasgunsaifldtuasdosannsnsosiudmiinvestgeonyldlneUaenfouarlaifin

audesla qlastmiinvesdigiengildimualilunismeaeusmelsunsude 100 Alan3u
4.2 M319UUUAIETUTUNTUADNNILADS

TUNITMALUUTUEIUAN 103gUnIalliy audonldmsiesevmedsinluidduw 3938ms

(%
a

Nakuvauiialaealuaziivunoundney 3 Tuneuseiugail

4.2.1 UABUNISLIATES Sketch Tun1sanawuy 2 6

3 @ E [P|l1] Mirror Entities

Trim Convert LR . \ !
BT DEnititiss Offset L Linear Sketch Pattern

Entities
- - .~ Muove Entities =

ASLYANe Sketch @unsavinlaanntunausalui
11Aenesasilotasiloudumuntaeanwuuld

2. AMvuavuInes asildeenwuuld

JUT 4.3 UAAINITNALUUTUITLLAZNITMVUATUIAYDILAAZEIU



4.2.2 JundUNITITANEY Extruded tiawasunuu 2 Aalvdanununduduau 3 48

Gl

Extruded
Boss/Base

UM 4.4 uansAnda Extrude

ASIUANEY Extruded @nunsavinlaanntusausalui

1.LABNTEUIVUUBUUTADINTEAUAITUAUA

2. AMUUAAITURUNUDITUIIUY

» {5 0000000 (Default<<Default>_Display State 15)

EN I

@] Boss-Extrudet
v X @

From

Direction 1

@

df D [
)

| St

& [s0omm

Draft autward

[ Direction 2

l(!

3
U

U

Selected Contours ry
O Sketchl-Region<i> 1

=)
7

4.5 LAMIUUNIUNITIIANES Extruded

33



5UN 4.6 UansBunuiinIsinuanunuInIgade Extruded 138USB8LAY

4.2.3 JURBUNITIYANSS Extruded cut bNIAUAMURUIVES BN VBIUNNEIUVDITUITU

@

Extruded
Cut

gﬂﬁ 4.7 uansAda Extruded cut

ASMUANEY Extruded cut @nunsavinldanntunausalul
1A UUUUTUINUAILTABINITHANY
2 L A9NNUNUUBUUNADINISLAE

3. MUUAAINUANVDINTTLANE

JUT 4.8 LAAINITINALUUNABINITIIUUTUNY
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EIREREIE

Cut-Extrudel
v X ®

From

Direction 1

[Through Al

1

[ Flip side to cut

Draft outward
[ pirection 2

Selected Contours

0 Sketch2-Region<1>
Sketch2-Region<1>
Sketch2-Region<2>
Sketch2-Region<2=

5UN 4.10 UARPUUMANEINEAEY Extruded cut 138UTp8UA7

4 @ 0000000 (Default<<Default:_Display State 1:)
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4.3 N13UTENBULUUTUNUNNAIUALAES Assembly nauaziirlunaaaudelusunsy

ABUNLADS

NAIANVININITODNUUULAL EIUTUNULAALEIULS BUSRELAT aLlUmEs Assembly Tunsuseneu

v

FUINUBABLAIUTNAE A UTT U LN LU UUTENBUT AT

4.3.1 Fuaudung qiazdudsenau

JUN 4.11 uanadudiuuunnes



JUN 4.12 uansiudiuee

g‘dﬁ 4.13 wa@nITudIU linear actuator 1
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5UM 4.14 uanafudiu linear actuator 2

5UN 4.15 uanafududueniy
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UN 4.16 wansdualunsausiun

7 4.17 uansgududuenas
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UM 4.18 uanagudluimadiusen

JUT 4.19 uansdudiuanin
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4.20 LAMSTUEIULAN A

4.21 LAnIYUAIULDIU
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SUN 4.22 UanuaILLILENIUNT

JUN 4.23 WanaBuUAILLIUENAUNAS
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UM 4.24 uansudiumdniledu

3UN 4.25 uansfudiuuiugauvuen



JUN 4.26 uanatudiuuausostn

5UN 4.27 uanafudiuuausogIua
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5UM 4.28 LanIFUAIULNUTIIU linear actuator

3UM 4.29 uansudIugIuge
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5U# 4.30 UansfiudIuYLaAuuY

5UM 4.31 wanagudiugiu 1



JUN 4.32 Lansiudiugiu 2

5UN 4.33 uanafudiugiu 3
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JUN 4.34 wanagudiugu 4

JUN 4.35 UanaudiugIuINuUnLaes
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JUN 4.36 Uangudiugu 5

SUN 4.37 uanagudiuainAgiu
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JUT 4.39 uansludiugu linear actuator 619
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JUN 4.40 wanaguadiugIu 6

JUN 4.41 uansudiunauenmian

51



U

3
U

=D,

Uil

4.43 LAAITUAIUNADLTDUUABLYUEN

52



JUN 4.45 UAMITUAILLHLADARIUENAEAN

53



54

4.3.2 NM5UTZNBUTUUAIWAIEY Assembly

[

NSLUAIET Assembly Tun1sUszna U uTAg

L. Ualusunsu uandenladau Assembly A9il File > New > Assembly

Part Assembly Dirawing
a 3D representation of a single design a z0r arrangement af parts and/or other aZbengineering drawing, typically of a
camparent 3Fssemiblies part oF assembly
i 7l
[Advanced Cancel Help :|

5UN 4.46 uanan1siaenAIds Assembly

2. 13UNTUNUNABINITUTZNBUTULIAIBAIET Insert Components

E‘.‘E
Insert
Components

-

5UN 4.47 uanan1siiendds Assembly
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E)g Insert Component @E @
L ]
Message F

Select a part or assembly to insert and
then place the component in the graphics
area, Use the push pin to insert multiple
copies of the same or different
components.

Hit OK button to insert a component at
the origin.

Part/Assembly to Insert -

Open documents:

Thumbnail Preview p-

Options -~

E Start command when creating new
assembly

[ Graphies preview
|:| Make virtual
|:| Envelope

@ Show Rotate context toolbar

JUN 4.48 uansvisingiasesile Insert components

= A

5UN 4.49 uansduaufignifenduan



3. 11TUNULNYTENBUNUMIUTDDNLUUMIEANET Mate

S E R[OS

Q Coincident2 &F o
v x 9 [F]
Qv [P |

Mate Selections N

<l

Standard Mates L2

Parallel
Perpendicular
O\ Tangent

©) concentric

@]

Mate alignment:

Advanced Mates

<

<

Mechanical Mates

Mates a

= A Coincident1 (wnuunnin<l> | \

<N >

Options ~
[JAdd to new folder

[ Show popup dialog

[ show preview

[ use for positioning only. Y.

o~ M1 1A -
D -

N

Mate

gﬂﬁ 4.50 LansFds Mate

> @8 Assem? (Default<Display...
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5UN 4.51 uanan15usenausigAds Mate
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JUN 4.52 uansuaunuseneumeaige Mate

4.53 LanITuNUNUsENaUssusaukaInautn luALIUmelUSHNSUABLNILADS
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NANISNAEDULUUINEDINIUSLATUADUNILADS

5.1 MSNAFBULUUINGRIQUNTalYIEIARaUd YR

lun1snageukuuiaesmelusinsuneuiimesazfesinmsiuaruaURveianluusiay
Fua nsidenmihdndniunisldusanseyihiiinanisiulsedasiasiavesgunsal msfmuavuing

WaETIAVNIVDILTINTBI I NABINUNTYINIUAT AT runA T unausa LUl

JUN 5.1 wuuinassgunsalundgeengainsadudiieTusasud

5.1.1 MmadAnAuaudRianvesiuuIngaes

[
Y [y

1. 1 F0NTUNU LB NIAERAIAIENTDITUI



Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | SOLIDWORKS MBD | SOLIDWORKS CAM | SOLIDWORKS Inspection

[ @A ©
@,

@ () 454> (Default<<Defauit>_D ~
@ () 67.75< 1> (Default< <Default>_
@@ () 617.7542> (Default<<Default_
% (-) 6x7.75<3> (Default<<Default>_
@@ () 617.754> (Default<<Default_
@ (-) 6x7.75< 5> (Default<<Default>_
@@ () 6:7.75<6> (Default< <Default>_
@ (-) 6x7.75< 7> (Default<<Default>_
% (-) 6x7.75<8> (Default<<Default>_
@@ () 67,759 (Defaults<Default>_
% (-) 6x7.75<10> (Default< <Default>
@ () 6x7.75<11> (Defauit< <Defaule>
@) () 6x7.75¢ 14> (Default< <Defoults
@ () 67.75<15> (Default< <Default>
@) () 6x7.75¢ 165> (Default< <Defaults
@ () 6x7.75<18> (Default< <Default> :I
@ () 67.75420> (Defauit< <Defaule>

@ (-) Linear main<1> (Default< < Defi
L % (-) Lingar sub<1> (Default<<Defav
» &8 () Battery<1> (Default<<Default>
v @ A\ () Switch main<1s Default<
» @ () Switch down<1> (Default<<De
» (-) Switch up<1> (Default<<Defau
o () s efault< <Defaul
[[CT ter Wheel<1> (Default<Disp
v €5 () seidac2> (Default<<Ds

» |48 () Caster Wheel foult<Disp
E (-) Caster Wheel<3> (Default<Disp
4 (-) urivsnidn 3z < <Defaut
» (-) Caster Wheel<4: Edﬂuh(ﬂ\sp
» | ) sinsoidosd> (Detaults<Detaut
Bdaeyen<> (Defanit)

» | () gu2<1> (Defauli< <Defau ‘fk:

&l

» [ @ gr2<2> Delault<<D
> () Mates R
<

>
Model [ 30Views | Mofion Study 1 |
Select entities to modify their appearance.

JUN 5.2 uanimsidonduaudiuiluman

1 [
1 =

2. AANYNANUNIIETNUIAN9TUN TAden Material siamae 1@an Edit Material

Selection Tools I3
| Zoem/Pan/Rotate »
Recent Commands 3
Go To...
Component
Make Virtual
| Isolate

| {% Configure Component

N Hide
| Component Display ¥ Edit Material
| 1% Suppress Plain Carbon Steel
Fix | Cost Alloy steet
Lr Move with Triad | ABSPC
@5 Temporary Fix/Group Malleable Cast Iran
Form New Subassembly 1060 Alloy
& Copy with Mates Brass
7€ Delete Copper
) Addto Favorites PBT General Purpose
Save Selection Nickel
£ Add to New Folder Rubber
Material » Customize Menu
Appearance »

Component Properties..

v L%

3UN 5.3 uanamsifenmdedmiunisseutoyaian

U 9



Close

v [ig) steal

5= 1023 Carban Steel Sheet (5]
8= 201 Annealed Stainless Steel (55)
8= 4286 Iron Base Superalloy
8= AISI 1010 Steel, hot rolled bar
5= AISI 1015 Steel, Cold Drawn (55}
8= Aisi 1020

§= AISI 1020 Steel, Cold Rolled

8= AISI 1035 Steel [55)

Material properties
Materials in the default library can not be edited. You must first copy the material
to a custom library to edit it.

Model Type:

Units: SI - N/mm*2 (MPa} v

Mame: AIS| 1045 Steel, cold drawn

Description:

mEsaurce: I

o=t —_
! sustzinability; | Defined

ealed Stainless Steel (5!
130 Steel, anneal k
AISI 4130 steel,}’%g
= AIS! 4340 Steel, anncaled

B= AISI 4340 Steel, normaliz

Y i N

- (ol e

PP

Uil 5.4 uansmsidentanAls 1045

5197l 5.1 pauaNdAnIsnavesian ASl 1045 steel

Cateaons |_Stee| e AN Y |

Mame? [ 41511045 Stael, cold drawn |

Drefault failure
criterion;

Dvescription:
SOMFE

|, Sustainabilit | Defined 3

61

3. MvuanuaudRvesianinedonlddan AISI 1045 steel uaI33nA Apply kdIrasIena



M1319% 5.2 Anaudnanavesan Cast Carbon Steel

Mame: | Cast Carbon Steel |

Description: | |

Saurce: | |

Sustainability: | Defined |

Property Value |Units ¢

4. vwuudeanuiutel fe 903 laadenanliaanduasveuafia lngdneda

NANS7I8.2 Fade G 3539 daydnwel SWCH

M19197 5.3 Landnunizveddaniitdinadn

Normal iron wire
Annealed fron wire SWM-B  |General and for metal mesh

wire e T i SWM-A  General and for metal mesh

Hot-dip aluminum plated iron wire SN | (hor 0%

énd bt SWMA Various metal mesh

Hard steel wire SW ‘Various wire springs, wire rope, steel
cord, bead wire and spoke wire

PC hard steel wire SWCR |Prestressed concrete tank and pipe

SWCD

Wire rope \Wire rope

Qil temper wire for spring. SWO-A  Warious wire spring

2Zinc plated stranded steel wire and B ‘Overhead earth wire, counterpoise and

Hot-dip aluminum plated iron wire catenary wire

and steel wire SWHA Overhead earth wire, catenary wire and
core wire for ACSR

Plano wire SWP Valve spring. music wire, high-class rope
and steel cord

PC steel wire and PC stranded steel|SWPR Prestressed concrete.

wire SWPD

Oil temper wire for valve spring SWO-V Valve spring

Hot-dip aluminum plated iron wire |SWHA Overhead earth wire, catenary wire and

and steel wire core wire for ACSR

Carbon steel wire for cold forging |SWCH Bolts, nuts, small screws and rivets

Core wire of film arc welding bar  |SWY Core wire for welding bar
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5.1.2 nMssenlgAnda Simulation

| 1

1. IngUn@Ads Simulation %agﬂuuawﬁwmmuuumaﬂﬂmﬂiu wenbad 157

a o

LABNINNSH8NANET Simulation aanUNNBU tnedRonIl
(1donAds Add- Ins... fisgun 5.5(n)

(2Ndnsesmnegnludesdmasumii SOLIDWORKS Simulation 3nntuiden OK fagufl

5.5(%)

Last Load | a
Time

Active Add-ins

Start Up

El SOLIDWORKS Premium Add-ins
5@ CircuitWorks

Dgﬁ FeatureWarks

1Y Photoview 360

O % SeanTo3D

D@: SOLIDWORKS Design Checker
[ # SOLDWORKS Motion

O ﬁg SOLIDWORKS Routing

1% SOLDWORKS Simulation

|:| ? SOLIDWORKS Toolbox Library
? a @ O SOLIDWORKS Toolbox Utilities
| N D%i SOLIDWORKS Utilities
@ {:\5"} Options
|

Move Customize...
! Component | Ad:_i—.—lnks;-.: iy

<1s

1s
45
2s

[]  sOLIDWORKS Workgroup PDM 2017

D TolAnalyst

Ooooooooooooo

E SOLIDWORKS Add-ins
N A | S 711% 7 > O Autotrace
Save/Restore Settings... 1 SOLIDWORKS Composer

stion | SOLIDY '
Button Size 3 —

]38 SOLIDWORKS Electrical
|

- |

1om®md

CALIMIAIARYE Bl Cimmedokinn 3047

(n) (v)
JUT 5.5 (MuaninisidenA1ds Add-Ins... wag (vuaninsidenlyends Simulation
5.1.3 Tupaunis Simulation

(1) 1donede Simulation > New Study > Static uaIdeNLATMILNEYNHETE?
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Assembly | Leyout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Simulation | SOLIDWORKS MBD
-

S E B e8]

Study @

» {g Q000000000000 (Default<Display State-13)

¥ X w
Message ~
Study stresses, displacements, strains and factor of safety for

components with linear material

Name ~

[ static 1

Type ]

Static

Thermal
Frequency

1 - .

5UN 5.6 uansduneuinilaveanis Simulation

1% ¥

(2) idonyanfeinisilugadudn Juumeunsil Adnua1# Fixtures > Fixed Geometry...> 1dan

vy & v & o = Y A & a
BRNN 4SLVL1JUF\!@7\]‘UU@ LLaULa@ﬂLﬂi@QMNqHQﬂaLGUU'J

& EER[® &0

Fixcture @
v K o+
Example -~
Standard (Fixed Geometry) e

Fixed Geometry
@ Raller/Slider
Fixed Hinge }

([ | | Face<1>@Caster Wheel-1/Casty n
Face<2> @Caster Wheel-1/Castt
Face<2> @Caster Wheel-2/Cast«
Face<3> @Caster Wheel-2/Castt
Face<3>@Caster Wheel-1 bs

<A

Advanced

Symbol Settings hd

5UN 5.7 uansnsiienyadutn

(3)nslausanssyiianueiiinasiolasiasnwesgunsal
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Tunslduseilaziinsansein 2 egreiiiinasiolasasneme wsaiiinandminvesUis waghs
Wnannusaltugisvedan

lngusaiinanimiinvesdieannsavilaned adnyfAds External Loads > Force... >

FonTEuIUNURINILTINTEY > Wasuniegveausadu Metric (G) > AMAUALIIVLIA 100 kef > 1don

Total MNMwFRNATRMLNEYNEITEN

S BB

lJ »
Force/Torque @

v X ™

Force/Torque A

Force
@ Torque

@ BlEate<1> ondon | 0 e | Force Value(Total) (kaf):| 100
| Face<2> @éfo-1 {
| Face<3> @#da-1 !

Face<4> @aflo-1 !
4

]

@ Normal
(O Selected direction

E| @eti{ @

4 [0 ~ |kgf

[JReverse direction
(O Per item
@ Total

TR B[

[J Nonuniform Distribution

<

Symbol Settings

<

5UN 5.8 uaninsseylseiliinanivinvesiae

drunsseulsnfnnusdduaedlanainsavinlacail ainvNAEs External Loads >

Gravity > \deniirmisvatuseliuaae lunsalilliiden Top Plane a1ntudeniasomunegnalen
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@ ER|&[@|TT

Gravity @
v X
Selected Reference A
D | EE—
I
Reverse direction
Advanced v
Symbol Settings v
_l
]

%Normal To Plane [m/sAZ]:l 881 l

JUN 5.9 LanINIsTEULsnInus Ll vvedlan

(%
Y

(HNSAIAUAIUINVDS Mesh BN SNadouTuIU WnedTUnaunIl AN Mesh >
Create Mesh... > WasukauAINazdenlusu Fine >  Standard Mesh > YSuruinauaztdenlmdy
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g=—
A
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P = ussnsueniiunnsyyin dviedu N wise kef wise (bf

A = Nunn1adAU19LTINT2yi1 Tutieidu m2 59 mm?2 13 in2
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von Mises (Nm”2)
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A1 Strain A9 HATBINIINTLYIVBIRSINBUBNADTAR MiiauaviTlAAnN1SA UM UYD LSS
meluvesiaguiniy widinavinlitanuasusulume dufeianizdaduileTulseie uazvaduilesu
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5.2.3 NANIIVAEBUTLAAINIINTTN (Displacement)
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5.2.4 nan1svadauinaninimulasnde (Factor of Safety)
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